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Abstract:- Swarm robotics is a way of organising huge 

num- bers of primarily straightforward physical robots in 

multi-robot systems. A desired collective behaviour is 

thought to originate from the interplay between the robot 

and how it interacts with its surroundings. This project 

provides applications, im- plementation information, and 

utilizing various technologies, meet hardware and design 

requirements. In the swarm robotics problem, 

cooperation swarm organisation, which emerges from the 

system itself, and the urge to solve problems are referred 

to as solution capability. Decentralization is achieved by 

allowing local contact between individual robots. 

communicating with Using the inexpensive nRF24L01 

wireless transceiver module, which is made for very low 

power consumption, robots wireless power application 

Communication between two or more microcontroller 

platforms makes it possible to Our performance 

coordination. We employ two nRF24L01 modules, each of 

which contains VCC, CSN, and MOSI and IRQ pins are 

inexpensive and simple to interact with. One is associated 

with the transmitter, whereas another There are GND, 

CE, SCK, and MISO pins on the receiver. nRF24L01 

transceiver is attached to a microcontroller. SPI 

communication protocol is used by the module (which 

uses master and slave concept). 

 

I. INTRODUCTION 

 

Some of the best characteristics of humans include inter- 

acting, comprehending, and then reacting to the environment. 

These traits are what define who we are as a species. Humans 

have always known that we are the most polite social 

creatures that have existed on this planet since it was created 

because we are designed from birth to live in a social society. 

Other species of this planet, such as a group of birds, fish, or 

bees, also exhibit social behaviour and interaction with one 
another in order to further a common objective. This is a 

trait that all of these species share with humans. When birds 

migrate, it’s common to see them in groups that are headed by 

the leader. Despite the fact that birds have no sense of shapes 

or figures, the lead member of their group directs the others, 

and everyone follows them. The group is also organised so 

that the older members are on the edges and the younger 

members, or the newborns, are in the middle. 

 

The same traits are present in fire ants, which differ 

slightly from other kinds of ants in that they establish their 
colonies collectively and define their preys as a group. In 

other words, they are aware that they can do more when they 

work as a team. They were discovered to be capable of 

building sturdy structures if necessary, such as when needed 

to build a shortbridge to cross, in a recent study on the 
collective behaviour of these ants. Despite all of their 

limitations, these social animals and insects accomplish more 

thanks to their collective behaviour. Researchers have shown 

that members of these groups do not require sophisticated 

knowledge or represen- tation. Individuals in social insects, 

mammals, and birds are not aware of the overall health of the 

colony. All of the agents share in the swarm’s information, so 

that no one agent can complete their task independently of 

the rest of the swarm. 

 

The ability to communicate between two or more 

microcon- troller platforms allow us to carry out interesting 
projects, such as automatic control of home appliances, in the 

fieldof robotics, and game controllers, to name a few. This 

com- munication can be achieved wireless or over wires. 

Among other technologies, wireless communication can be 

conducted utilising WiFi, Bluetooth, RF, GSM/GPRS and 

LoRaWAN. 

 

II. LITERATURE SURVEY 

 

A. Swarm Robot coordination 

Mondada and Pettinaro introduced the idea of a group 
of autonomous mobile robots known as S-BOTs, or ”swarm- 

bots.” S-BOTs may physically connect to one another 

because to a unique assembling ability. SWARM-BOT, which 

consists of 10 to 30 S-BOTs networked together, is far more 

durable than a single bot and is capable of handling 

challenging jobs even in challenging environmental 

circumstances. A K- neighbor restriction was suggested by 

Poduri and Sukhatme to maximise the area coverage of a 

mobile sensor network during self-deployment. The main goal 

of the strategy is to coordinate the placement of mobile 

sensors using two forces: Fcover, which makes nodes reject 

one another in order to extend their coverage, and Fdegree, 
which makes nodes attract one another in order to have more 

neighbours. When the two forces are equivalent, an anode 

stabilises its position. 

 

B. Self Assembly 

Jhang Jian Ju, et al., envisioned in order to increase the 

effectiveness of the swarm robot’s self-assembly process and 

enable dynamic local navigation of random movement in ac- 

cordance with the distance between the seed robot and 

docking robot, Jhang Jian Ju, et al. devised a self-assembly 

distributed control method. Additionally, this paper 
investigated the time efficiency of morphology using line, 

arrow, T, and star shapes. 
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This method boosts the effectiveness of self-assembly. 

Harish Verlekar, et al.,developed a strategy based on the 
imitation of the division of labour in bees and the chain 

creation behaviour of ants was proposed by Harish Verlekar, 

et al. Swarm robots, which are made to resemble ants, create 

chains while foraging and employ the division of labour to 

reduce energy waste. A computer vision-based method is 

combined with magnetic sensor readings for localization and 

navigation. Swarm robot technology provides parallelism, 

robustness, and scalability. 

 

C. QoS support in wireless ad hoc networks 

Xue and Ganz, proposed a QoS routing protocol with 

admission control enforced to enable quality of service 
inmulti- hop ad hoc networks is presented as Ad hoc QoS on- 

demand routing (AQOR). ad hoc networks By taking into 

account the competition for fall nodes inside the carrier 

sensing area, Yang and Kravets suggested to enforce 

admission control. To get nearby information, nevertheless, 

requires highpower usage. Additionally, when estimating 

bandwidth, they did not take link rate and traffic into account. 

It was suggested by Chen and Heinzelman to determine 

available bandwidth by local estimation and message 

exchange among nearby nodes. They then used the Li and 

Blake result to adjust for intra-flow interference. However, 
even with multi-rate enabled, this result is not precise enough. 

Due to transmission ata high data rate while using a multi-

rate MAC, the link’sdistance may be significantly reduced, 

increasing intra-flow interference. When making an 

admission control decision, Li and Prabhakaran proposed 

route available bandwidth (RAB) and route reliability (RR) 

metrics to take into account both mobility, multi-rate feature, 

and multi-link interference. 

 

D. Obstacle Avoidance 

Syed IrfanAli Meerza, et al. offered a technique to 

guide a mobile robot toward a target and navigate across a 
space without knowing anything about it beforehand. In order 

to design a robot’s course, this work introduces the particle 

swarm optimization (PSO) with dynamic obstacle avoidance 

technique. In the Processing IDE, we simulate and test the 

various contexts for our proposed solutions. This system’s 

feature is its computational simplicity, and it also uses less 

memory. 

 

E. Behaviour 

Harish Verlekar, et al developed an approach based on 

the imitation of the division of labour in bees and the chain 
forming behaviour of ants. Swarm robots, which are madeto 

resemble ants, create chains while foraging and employ the 

division of labour to reduce energy waste. A computer vision- 

based method is combined with magnetic sensor readings for 

localization and navigation. We achieve parallelism, robust- 

ness, and scalability by using swarm robots. 

 

 

 

 

 
 

 

III. PROPOSED SYSTEM 

 
In this paper, We suggest a brand-new design known as 

robotswarm communication networks. Robots are 

clustered into one or more teams or swarms in this 

architecture, and each swarm can be monitored and managed 

by some central servers using a wireless mesh backbone and 

the Internet. A self- organizing mobile ad hoc network 

develops within each swarm such that all robots remain 

connected to one another despite movement. Mobile users 

can also keep an eye on swarms using portable gadgets like 

computers and PDAs, and they can respond right away based 

on the data they gather. Location, topology, and other 

relevant information might be included in the monitoring 
module. It is also suggested that images and videos be 

transmitted from robots to servers or mobile users so that 

suitable decisions can be made. From the perspectives of both 

software system development and protocol design, the 

suggested architecture presents new issues. 

 

On the other hand, it’s crucial for the system to be im- 

plemented how to create a software system to effectively 

monitor, coordinate, and operate robot swarms. Additionally, 

the wireless mesh network backbone must offer quality of 

service (QoS) for robots streaming video. 
 

IV. BLOCK DIAGRAM 

 

 
Fig 1 

 

V. HARDWARE AND SOFTWARE 
 

A. ARDUINO UNO (ATMEGA 328) 

The Arduino UNO microcontroller was used in our 

project. The ATmega328P-based Uno is a microcontroller 

board. It has 14 digital input/output pins, 6 analogue inputs, a 

16 MHz quartz crystal, a USB connection, a power jack, an 

ICSP header, and a reset button. It comes with everything you 

need to support the microcontroller; simply connect it to a 

computer via USB or power it via an AC-to-DC adapter or 

battery to get started. You can tinker with your UNO without 

fear of doing something incorrectly; in the worst-case 
scenario, you can replace the chip for a few dollars and 

restart. 
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Fig 2:- Arduino UNO (Atmega 328) 

 

In this paper, we are using this module to demonstrate 

how wireless communication between Arduino modules can 

be achieved using the lowcost RF (radio frequency) based 

nRF24L01+ transceiver module The first benefit of these 

modules is their low price. One can be purchased for less than 

2 dollars. Using the SPI protocol, nRF24L01+ modules can 

be easily interfaced to a wide range of microcontrollers 

including MCU, ARM, PIC, AVR, and STM32. When 

compared tolower operating frequencies, 2.4GHz allows for 
higher bit rateusages. The Nrf24L01+ module transmits data 

using GFSK modulation, so the data transfer rate can be 

250kbps, 1Mbps, or 2Mbps. The operating voltage for these 

modules ranges from 1.9 to 3.6V, but the logic pins are 5V 

tolerant, so they canbe easily connected to any 5V logic 

microcontroller without the use of a logic level converter. 

During transmission, the power consumption is 

approximately 12mA, which is even lower than a single LED 

therefore making this the best choice for wireless device in 

low power applications. gallium phosphide, and gallium 

arsenide (GaAsP) (AlGaAs). As a result of the 
electroluminescence phenomena, LEDs 

 

 
Fig 3:- LED 

 

Produce visible radiation when a low voltage direct 

current is applied to a suitably doped crystal containing a p-n 

junction. Usually, elements from columns III and V of the 

periodic table are used for the doping. When the p-n junction 

is activated by a forward biassed current (IF), it produces light 
with a wavelength determined by the active region. 

 

C. Push Button 

It is a small switch that completes an electric circuit 

when you press on it. When its on a small metal spring inside 

makes contact with two wires , allowing electricity to flow. 

 

 
Fig 4:- Nrf24l01 Module 

 

D. Jumper Wires 

 

 
Fig 5:- Push Button 

 

1.9 to 3.6V is the range of operating module of this 

module and the logical pins being 5V tolerant. So, Logic level 
conversion is not required to connect it to any 5V logic 

microcontroller. The module upholds programmable result 

power viz. 0 dBm, - 6 dBm, - 12 dBm or - 18 dBm and 

consumes unimaginably around 12 mA during transmission 

at 0 dBm, which is even lower than an LED. What’s more, 

the best part is that it consumes 26 µA in backup mode and 

900 nA at shut down mode. That is the reason they’re the go-

to remote gadget for low-power application. The SPI transport 

utilizes an idea of a Master and Slave, in most normal 

applications our Arduino is the Master and the nRF24L01+ 

handset module is the Slave. Not at all like the I2C transport 
the quantity of slaves on the SPI transport is restricted, on the 

Arduino Uno you can utilize a limit of two SPI slaves for 

example two nRF24L01+ handset module. 

 

B. LED 

A specific kind of PN junction diode is a light-emitting 

diode (LED). The light-emitting diode is built of a unique 

kindof semiconductor and is specifically doped. When placed 

in the ”on” position, this diode may produce forward-biased 

con- dition. Indium gallium nitride with aluminium indium 

gallium phosphide (AlInGaP) (InGaN) are two of the 

semiconductors for LED technologies that are most 
frequently employed. employed older LED technology. 

Aluminum gallium arsenide, Jumper wires are just wires that 

have connector pins at each end, permitting them to be utilized 

to interface two points to one another without soldering. 

Jumper wires are commonly utilized with breadboards and 

other prototyping devices to make it simple to change a 

circuit on a case by case basis. Genuinely straightforward. It 

doesn’t get considerably more essential than jumper wires, as 

a matter of fact. Howeverjumper wires arrive in various 

varieties, the tones don’t really make a difference. This 

implies that a red jumper wire is in fact equivalent to a dark 
one. However, the varieties can be utilized for your potential 

benefit to separate between sorts of associations, like ground 

or power. Jumper wires commonly come in three variants: 

male-to-male, male-to-female and femaleto-female. The 
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distinction between each is in the end point of the wire. Male 

closures have a pin distending and can plug into things, while 
female finishes don’t and are utilized to plug things into. 

Male-to-male jumper wires are the most widely recognized 

and what you probably will utilize most frequently. While 

interfacing two ports on a breadboard, a male-to-male wire 

you’ll require. 

 

E. Arduino Software Ide 

Since Arduino is an open-source project, hobbyists can 

readily utilise the potent ATMega chips. The software used 

to develop code and upload it to the ATMega chip is called 

the Arduino IDE. The chip then runs the code in question. 

 

 
Fig 6:- Jumper Wires 

 

The majority of 3D printer electronics are compatible 

with Ar- duino; they make use of the ATMega chip and let 

users upload their own code using Arduino. Megatronics, 
Minitronics, and RAMPS are all included in this. You need 

software firmware that converts machine instructions into 

actual motions before you can use the electronics. Several 

variations are available, including Marlin, Sprinter, and 

Repeater. 

 

You must first use File Open to open the files in 

order to upload a firmware. From the directory containing the 

firmware, choose the.ino file. Arduino will launch numerous 

tabs containing files. The appropriate electronics board must 

then be chosen. Find the Board item under the Tools menu. 

Megatronics, Minitronics, Arduino Mega 2560 (RAMPS 
with Mega 2560), and Arduino Mega 1280 are a few sub 

items that this item should have (RAMPS with mega1280). 

Choose a board for your electronics. The serial port that the 

electronics are linked to must also be chosen. Find the Serial 

port item under the Tools menu. If the board is connected and 

the drivers are correctly loaded, this should include at least 

one item. If there are additional items, you really want to 

figureout which is the right one by turning off the board and 

checking which port was eliminated. Whenever you have set 

the board and sequential port, you can transfer the firmware 

by squeezing File → Upload. Arduino will attempt to order 
the firmware, assuming any mistakes happen the cycle will 

stop and you should fix the blunders prior to attempting once 

more. When accumulation is finished, the genuine transfer 

will begin. This might require a moment for a larges ketch. 

Arduino programming is the instrument to consume the hex 

document on the chip. It gives the plat structure to circuit 

format, circuit plan and real time execution. 

 

 

VI. DESIGN AND IMPLEMENTATION 

 
A. Hardware Implementation 

First of all, plug all thirty female-male jumper pins to 

the Arduino. Then, connect the positive (+) pin of the sensor 

and 3.3v (+5 volts) of your Arduino to VCC on breadboard, 

the ground (-) pin of your sensor and GND (-) of your 

Arduino to GND on breadboard. Enable CE pin of the sensor 

to determine whether module is transmitting or receiving data. 

MOSI is master out slave in which is the SPI input to the 

module. CSN is chip select not is an active low pin but is 

normally kept high so that when it turns low the module 

begins listening to its SPI port for data processing SCK. 

Serial clock for accepting clock pulses from the SPI bus 
master. MISO is master in slave out in which SPI output to 

the module. IRQ is an interrupt pin but in most of the 

projects with Arduino not used. For SCK pin 13, MISO pin 

12, MOSI pin 11 is used. Once all of the connections have 

been done, you are ready to go onto the software side of this 

project. 

 

B. Software Implementation Programming ARDUINO 

Once Arduino IDE is installed on the computer, con- 

nect the board with computer using USB cable. Now openthe 

46rduino IDE and choose the correct board by se- lecting 
Tools¿Boards¿Arduino/Genuino Uno, and choose the correct 

Port by selecting Tools¿Port. Arduino Uno is pro-grammed 

using Arduino programming language based on Wiring. To 

get it started with Arduino Uno board and blink the built-in 

LED, load the example code by selecting Files¿ Examples¿ 

Basics¿ Blink. Once the example code (also shown below) is 

loaded into your IDE, click on the ‘upload’ button given 

onthe top bar. Once the upload is finished, you should see the 

Arduino’s built-in LED blinking. 

 

1) Arduino – Program Structure: 

We will study in depth; the Arduino program structure 
and we will learn more new terminologies used in the Arduino 

world. It is free to get the Arduino software. The LGPL 

governs the licencing of C/C++ microcontroller libraries, 

while the GPL governs the source code for the Java 

environment. Sketch: The Arduino programme ”sketch” is 

the first example of new nomenclature. Structure The three 

basic components ofan Arduino programme are Structure, 

Values (variables and constants), and Functions. The Arduino 

software programme will be explained in detail in this 

tutorial, along with how to develop a programme without 

making any syntax or com- pilation mistakes. Starting with 
the Structure, please. There are two primary purposes of 

software structure: Configure() function () function loop 

PURPOSE: A sketch begins by calling the setup () function. 

Use it to start using libraries, pin modes, initialise the 

variables, etc. The setup process will only be executed once. 

 

INPUT: 

OUTPUT: 

RETURN: 
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PURPOSE: Following the creation of a setup () method that 

initialises and sets the initial settings, the loop() function 
performs exactly what its name implies: it loops sequentially, 

allowing your programme to evolve and respond. You can 

use it to directly control an Arduino board. 

 

INPUT: 

OUTPUT: 

RETURN: 

 

Then make an RF24 object with two arguments, using 

the CE and CSN pins as arguments. Pins 8 and 9 are being 

used in this instance, respectively. For the address or pipe that 

the two modules use to communicate, create a byte array. Any 
five- letter string will do. We use the radio.begin() procedure 

to initialise the radio object for Transmitter. The radio is on. 

The WritingPipe() function is used to set the address of the 

transmitter, whereas radio is used to set the address of the 

receiver. use openReadingPipe(). Since the modules are close 

to one another, we set the Power Amplifier level to minimal 

using the radio.setPALevel() function. The module is config- 

ured as transmitter by the radio.stopListening() function, and 

the radio.start Module is set as recipient via listening(). radio. 

write () function is used to communicate with the recipient. 

The message that we wish to transmit and the number of bytesin 
that message make up the first and second arguments for this 

function, respectively. The variable that stores the data to be 

transferred is denoted by the symbol ”,” and sizeof() returns 

all of the variable’s bytes. You can send up to 32 bytes at a 

time using this technique. Because the nRF24L01+ can only 

handle a single packet of such size. The radio.available() 

method for the receiver is used to determine whether data is 

available for reception. If there is data in the buffer, this 

function returns TRUE. The function radio.read() reads and 

stores information into a variable such as The state of LEDs 

is then managed by fbuttonState. How to Increase RF Signal 

Power. Any wireless communication system’s primary 
concern is communication range, which also determines the 

type of device to utilise for a given application. We can 

consider the following fixes to increase the nRF24L01+ 

module’s broadcast range. 

 

1. Utilizing bypass capacitors between the modules’ GND 

and 3.3V that have a capacitance of roughly 4.7 to 47 F 

will help reduce power supply noise and improve the 

modules’ operating voltage stability. An nRF24L01 

adaptor module can be used to accomplish this with ease. 

2. Altering your channel frequency to cut down on inter- 
ference from WiFi and other nearby wireless network 

signal sources. The nRF24L01+ module should typically 

operate between 2.40 and 2.524GHz. Using the 

radio.setChannel() function in the code, the frequency can 

be changed. For instance, the modules will speak at 2.421 

GHz if we use radio.setChannel(21). 

3. Significantly reducing the data transfer rate improves the 

range. The radio is used to set the data rate in the code.the 

setDataRate() method. The slowest speed available—250 

kbps—is denoted by the argument RF24-250KBPS, and 

it provides the widest range of data transfer. RF24-1MBPS 
stands for 1 Mbps, while RF24-2MBPS stands for 2 Mbps, 

providing a faster transfer speed but with a shorter range. 

VII. RESULTS 

 

 
Fig 7  

 

 
Fig 8  

 

VIII. CONCLUSION 

 
We demonstrated a straightforward swarm robot 

controller utilising an Arduino UNO and nRF24L01 

transceiver module. In order to use Arduino in a swarm 

robotics application, an experiment was conducted. Led is 

used to observe the master-slave method algorithm for 

multirobot communication. Here, one robot instructs other 

robots to perform a specific task; anytime we press a button, 

two LEDs light displays the predicted outcome and 

coordinates. 
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